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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

MyCourses

• Kurssilla käytetään MyCourses-ympäristöä:

https://mycourses.aalto.fi/course/view.php?id=35055

- Opetusmateriaali

- Harjoitustehtävien palautus

- Kurssin tiedotus

- Visailut
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tietokoneharjoitusten palauttaminen

• Tunti- ja kotitehtävät ovat kalvojen lopussa ja vaadittavat vastaukset

on merkitty seuraavasti:

- = kirjoita vastaus

v = liitä kuva

• Vastaukset palauttaan viikottain yhtenä pdf-tiedostona

MyCoursesiin, jossa nimi ja opiskelijanumero

• Kaikki tehtävät tehdään, arvostelu 0-6 pistettä seuraavasti:

1p muotoilusta

2p tuntitehtävistä

3p kotitehtävistä
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tietokoneharjoitusten palauttaminen

• Yhteenveto tietokoneharjoitusten palautuksiin vaadituista

muotoiluseikoista löytyy MyCoursesista ”Tietokoneharjoitus 1”

-välilehdeltä. Nämä muotoiluvaatimukset ovat nimensä mukaisesti

vaatimuksia, joita pitää lähtökohtaisesti seurata.

- Huomioi, että kurssin suuremmissa raporteissa on tämän lisäksi

erillisiä muotoiluvaatimuksia.

• Jos palautus myöhästyy deadlinesta, niin pisteistä vähennetään yksi

piste jokaista alkavaa vuorokautta kohden.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tietokoneharjoitusten korjaukset

• Jos et saanut palautuksesta täysiä pisteitä, niin sinulla on mahdollisuus

korottaa pisteitäsi korjaamalla palautusta saamasi palautteen

perusteella. Lopullinen pistemäärä on tällöin ensimmäisen ja toisen

palautuksen pisteiden keskiarvo. Eli esimerkiksi jos olet saanut neljä

pistettä, niin korjauksen jälkeen voit saada viisi pistettä. Pisteet eivät

voi laskea korjauspalautuksessa.

• Myöhästymisestä aiheutuneita pistemenetyksiä ei ole mahdollista saada

anteeksi korjauspalautuksessa.

• Assarit tarkastavat palautukset seuraavan viikon sunnuntaihin

mennessä, jonka jälkeen on viikko aikaa tehdä korjaukset ja palauttaa

korjattu versio MyCoursesiin vanhan version tilalle.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Ensimmäinen harjoituskierros

Aiheet

• Tutustuminen matemaattiseen mallintamiseen

• Tutustuminen Matlab-ohjelmistoon

• Tutustuminen Latex-ympäristöön

Oppimistavoitteet

1. Osaat käyttää Matlabin komentoikkunaa sekä komentojonotiedostoja.

Osaat tärkeimmät peruskomennot.

2. Osaat visualisoida tuloksia Matlabilla ja viedä visualisointeja

julkaisuihin
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matemaattinen mallintaminen

• Malli on todellisuuden jäljitelmä.

• Fysikaaliset lait, tilastollinen päättely, simulointi . . .

• Hyvä malli on mahdollisimman yksinkertainen. Sopiva

yksinkertaistuksen aste riippuu käyttätarkoitukesta.

• Mallin avulla systeemiä voidaan tarkastella ilman kokeiden tekemistä.

- Kokeiden tekeminen systeemistä voi olla liian vaikeaa, kallista, tai

mahdotonta.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

White Box - Black Box

• White box -malli: Systeemin riippuvuussuhteet tunnetaan.

- Luonnonlait

- Fysikaalinen mallintaminen

- Esim. sähköpiirin mallintaminen

• Black box -malli: Systeemin riippuvuussuhteita ei tunneta, vaan malli

sovitetaan mittausdataan.

- Identifiointi

- Esim. kansantalouden mallintaminen

• Välimaastossa Gray Box -mallintaminen

- Systeemin rakenne osittain tunnettu, mittausdataa käytetään

parametrien määrittämiseen.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Mallien käyttätarkoituksia 1/2

• Ennustaminen

- Esim. kuinka suuri sähkön kulutus tulee olemaan ensi vuonna?

• Optimointi

- Esim. mikä on paras mahdollinen tuotannon määrä yritykselle?

• Säätö

- Esim. kuinka paperikonetta tulisi ohjata, jotta lopputulos olisi

tasalaatuista?
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Mallien käyttätarkoituksia 2/2

• Päätöksenteko

- Esim. pitäisikö Suomeen rakentaa lisää ydinvoimaa?

• Maailmankuvan muodostaminen

- Esim. mitkä tekijät vaikuttavat Suomen kansantalouden

kehittymiseen?
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Mallien luokittelu 1/2

• Deterministinen - Stokastinen

• Dynaaminen - Staattinen

• Jatkuva-aikainen - diskreettiaikainen

• Keskitetyt parametrit - Jakautuneet parametrit

• Jatkuva-aikainen - Tapahtumaorientoitunut

• Parametrinen - Ei-parametrinen

• Single-input-single-output (SISO) - Multi-input-multi-output (MIMO)

• Lineaarinen - Epälineaarinen

• Aikavariantti - Aikainvariantti

• Aikatasomalli - Taajuustasomalli
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Mallien luokittelu 2/2

• Mallit voidaan myös jaotella aiheen mukaan:

- Matemaattiset mallit esim.

Fysiikassa

Lääketieteessä

Psykologiassa

Taloustieteessä

• TAI ratkaisutekniikan mukaan:

- Matemaattinen mallintaminen esim.

Differentiaaliyhtälöillä

Graafeilla

Matemaattisella ohjelmoinnilla

Neuroverkoilla
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Mallinrakennuksen vaiheet

(1) Tehtävän määrittely

(2) Mallin muodostaminen

- Puetaan kohdan (1) tehtävä matemaattiselle kielelle.

(3) Mallin ratkaiseminen

- Suoraviivaisin osuus, perustuu yleensä hyvin määriteltyyn

matemaattiseen teoriaan.

(4) Validointi

- Vastaako malli niihin kysymyksiin, johon sen piti vastata?

(5) Ratkaisun käyttöönotto

- Toimintaohjeita mallin käyttäjälle.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matlab

• Matlab (MATrix LABoratory): numeeriseen laskentaan tarkoitettu

ohjelma.

• Käytetään laajasti eri insinöörialoilla.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matlabin käyttöliittymä, toolboxit

• Command Window - Komentoja voidaan syöttää yksi kerrallaan.

• Workspace - Työtilaan tallennetut muuttujat.

• Editor - Ns. m-tiedostojen (funktioiden ja komentojonotiedostojen)

muokkaamista varten.

• Help - Minkä tahansa funktion helpin saa auki seuraavasti:

help funktio

• Matlabissa eri sovellusalueille tehtyjä valmiita työkalupaketteja

- Statistics Toolbox

- Optimization Toolbox

- Symbolic Math Toolbox

- Curve Fitting Toolbox
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matriisien käsittely Matlabissa

• Matriisit ovat perustietorakenne Matlabissa.

• Matriisit syötetään alkioittain hakasulkujen sisään.

• Välilyönti (tai pilkku) erottaa samalla rivillä olevat alkiot.

• Puolipiste erottaa rivit toisistaan.

• Vektorit luodaan vastaavalla tavalla.

A =


1 2 3

4 5 6

7 8 9


>> A=[1 2 3 ; 4 5 6 ; 7 8 9]

A =

1 2 3

4 5 6

7 8 9
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matriisin alkioihin viittaaminen 1/2

• Viittaus sulkujen avulla muodossa (rivi,sarake)

A =

1 2 3

4 5 6

7 8 9

>> A(2,1)

ans =

4

• Huom! Indeksointi alkaa 1:sta, ei 0:sta (toisin kuin esim. Javassa)
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matriisin alkioihin viittaaminen 2/2

• Voidaan myös viitata useamman alkion muodostamaan alueeseen

kaksoispisteen (:) avulla.

>> A(1:2,1)

ans =

1

4

>> A(:,1) % pelkkä kaksoispiste valitsee koko sarakkeen/rivin

ans =

1

4

7

>> A(2:end,1) % end viittaa viimeiseen alkioon

ans =

4

7
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matriisien muokkaaminen

• Matriiseja voidaan myös luoda liittämällä toisia matriiseja yhteen.

>> B=[A A]

B =

1 2 3 1 2 3

4 5 6 4 5 6

7 8 9 7 8 9

• Tiettyä matriisin alkiota voidaan muuttaa seuraavasti.

>> A(1,1)=100

A =

100 2 3

4 5 6

7 8 9
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Matriisin transpoosi

• Matriisin transpoosiin käytetään heittomerkkiä (’).

A =

1 2 3

4 5 6

7 8 9

>> A’

ans =

1 4 7

2 5 8

3 6 9
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Peruslaskutoimitukset 1/2

• Yhteen- ja vähennyslasku (+, -)

>> C=[1 2;3 4] , D=[5 6;7 8]

C =

1 2

3 4

D =

5 6

7 8

>> C+D

ans =

6 8

10 12

>> C-D

ans =

-4 -4

-4 -4
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Peruslaskutoimitukset 2/2

• Kerto- ja jakolasku (*, .*, /, ./)

>> C*D % Matriisitulo

ans =

19 22

43 50

>> C.*D % Alkioittainen tulo

ans =

5 12

21 32

>> C/D % Matriisijakolasku

(vastaa laskua C*inv(D))

ans =

3.0000 -2.0000

2.0000 -1.0000

>> C./D % Alkiottainen jakolasku

ans =

0.2000 0.3333

0.4286 0.5000
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Käänteismatriisi, lineaarisen yhtälöryhmän ratkaisu

• Matriisin A käänteismatriisi A−1 on olemassa täsmälleen silloin, kun

det(A) 6= 0.

• Käänteismatriisille pätee:

A ·A−1 = A−1 ·A = I (Yksikkömatriisi).

• Yhtälöryhmän A · x = b ratkaisu:

- A on n× n matriisi, x = [x1 . . . xn]T , b = [b1 . . . bn]T .

⇔ (A−1A)x = A−1b

⇔ Ix = A−1b

⇔ x = A−1b

- Matlabissa: x=inv(A)*b tai x=A \b
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Peräkkäisistä luvuista koostuvan vektorin luominen

• Kaksoispisteen (:) avulla voidaan luoda näitä vektoreita.

>> x=10:16

x =

10 11 12 13 14 15 16

>> y=10:2:16 % alkioiden välinen erotus 2

y =

10 12 14 16

• Huom! % on kommentointimerkki. (Matlab ei suorita sen jälkeen

samalla rivillä olevia komentoja.)
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Komentojonotiedostojen luominen editorilla

• Komentojonotiedoston (muotoa *.m) avulla voidaan ajaa usea komento

peräkkäin. Komentojonotiedosto luodaan editorilla, joka aukeaa

vasemman yläkulman kohdasta ”New Script” tai Ctrl+N.

• Komentojonotiedoston syntaksi on sama kuin komentorivillä

• Komentojonotiedosto ajetaan kirjoittamalla tiedoston nimi

komentoriville tai painamalla editorissa F5

• Komentojonotiedoston muuttujat tallentuvat Matlabin Workspaceen

– Muuttujat käytettävissä myös komentojonotiedoston suorittamisen

päätyttyä

– Komentojonotiedosto voi käyttää workspacessa olevia muuttujia

– Huom! Vaarana tallentaa tärkeiden muuttujien päälle
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

• HUOM! Käytä Matlabissa aina komentojonotiedostoja, kun suoritat

useamman kuin yhden komennon. Hyvä työskentelytapa tällä kurssilla

on esimerkiksi tehdä (vähintään) yksi komentojonotiedosto jokaista

tehtävää kohden.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Kuvaajat 1/2

• plot-funktion avulla voidaan piirtää kuvaajia, ks. help plot

>> x=-2*pi:0.1:2*pi; % Luodaan x-vektori

>> y=sin(x); % Luodaan y-vektori

>> plot(x,y); % Piirretään kuvaaja

(vaaka-akselilla x, pystyakselilla y)

>> grid on % Kuvaajan ruudukko päälle

>> axis tight % Akselit ilman tyhjää tilaa laidoilla

>> title(’Sinikäyrä’) % Kuvaajan otsikko

>> xlabel(’x-akseli’) % Tunniste x-akselille

>> ylabel(’y-akseli’) % Tunniste y-akselille

>> legend(’x’) % Kuvateksti

• Edelliset komennot kannattaisi kirjoittaa perätysten yhteen

komentojonotiedostoon, jotta niiden uudelleen ajaminen ja

muokkaaminen olisi tulevaisuudessa helpompaa.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Kuvaajat 2/2
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä A: Tutustuminen Matlabiin

Saat ohjeita komentojen käyttämiseen komennolla help. Esimerkiksi

help inv. Käytä helppiä hyväksesi aina kun et pääse muuten eteenpäin.

1. Luo muutama matriisi, esim. A=[1 2 3;3 2 1;4 5 60],

B=[1 2 3;4 5 6;7 8 9], C=eye(3), D=ones(3,2) ja E=zeros(2,3). Kokeile

matriisien yhteen- ja kertolaskua esimerkiksi matriiseilla A ja B. Kokeile

myös komentoja det, inv, diag, size ja eig.

- Mitä tekee funktio eig?

- Mitä tekee komento clear all?

2. Luo vektorit a=[1 2 3] ja b=[1 5 9].

- Mitä saat vastaukseksi seuraavista laskutoimituksista?

a*b’, a’*b, a.*b, a.*a, a.^2
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

3. Luo vektori jossa on luvut 1, 3, 5, ..., 99 kahdella eri tavalla:

kaksoispisteen käytöllä ja linspace-komennolla.

- Kirjoita komennot tarkasti vastauksiisi.

4. Piirrä funktion sin(x) kuvaaja välillä x ∈ [−π, π]. Piirrä samaan kuvaan

funktio cos(2x). Käytä piirtämiseen funktioita figure, plot, axis, grid,

ja hold on. Lisää kuvaan myös legend, sekä title, ja piirrä kuvaajat eri

tyylisillä viivoilla.

- Millä komennolla saat monta kuvaajaa samaan koordinaatistoon?

- Mitä tekee komento close all?
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Tutustuminen Overleafiin

• Overleaf on online Latex editori ja kääntäjä

1. Aloita menemällä osoitteeseen https://www.overleaf.com/edu/aalto

(Aallon kautta opiskelijoilla on Overleaf professional

lisenssioikeudet)

2. Luo itsellesi uusi käyttäjä (jos sinulla on jo Overleaf käyttäjä niin

voit tietenkin käyttää sitä)

3. Seuraavaksi klikkaa Projects oikeassa yläreunassa → klikkaa

Create First Project → Upload Project (tai New Project →
Upload Project jos olet käyttäny Overleafia aiemmin) → lataa

MyCoursesista Lisämateriaali-osiosta dokumentti.zip ja raahaa se

aukeavaan ikkunaan Overleafissa

Seuraavalla dialla kuva siitä, miltä tässä vaiheessa pitäisi suunnilleen

näyttää
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Tutustuminen Overleafiin

• % -merkillä alkavat lauseet ovat kommentteja, joita ei oteta huomioon

dokumenttia käännettäessä
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Kääntäminen pdf-tiedostoksi

• Jos Auto Compile -asetus on päällä, Overleaf kääntää tekstin jokaisen

muutoksen jälkeen dokumentiksi. Muussa tapauksessa voit aina

halutessasi kääntää tekstin painamalla Recompile painiketta

yläreunassa. Auto Compile asetusta voit muuttaa Recompile -painikkeen

viereisestä nuolesta avautuvasta valikosta.

• Valmiin pdf-dokumentin voit ladata Recompile painikkeen oikealla

puolella olevasta Download PDF painikkeesta

• Editori pyrkii varoittamaan virheistä. Osan virheistä se yrittää

käännösvaiheessa korjata automaattisesti. Näistä esimerkki seuraavassa

kuvassa, jossa käännös onnistui virheestä huolimatta, mutta virhe on

editorissa merkitty punaisella ruksilla ja Logs and output files

-kohdasta nähdään tarkempia tietoja virheestä ja sen korjauksesta.

• Jos käännös ei onnistu, näytetään virheilmoitukset automaattisesti
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Kääntäminen pdf-tiedostoksi

- Esimerkki: kääntäjä ilmoittaa virheen löytyvän riviltä 59

- Virhe: kirjoittaja on unohtanut lisätä $-merkin

- Korjaus: $-merkki lisättiin automaattisesti
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Valmis dokumentti

- Tämä ja seuraavat kuvat eivät ole Overleafista, mutta samat säännöt

pätevät muillakin Latex-kääntäjillä

SCI-C0200 Fysiikan ja matematiikan menetelmien studio 2023 35



Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Dokumentin muokkaaminen

1. Jatketaan dokumentin muokkaamista. Lisää yhtälö (2)

(normaalijakauman kertymäfunktio) dokumenttiin

Φ(x) =
1√
2π

∫ x

−∞
e−t

2/2dt (2)

- Tarvittavat symbolit ja komennot:

\Phi → Φ \frac{a}{b} → a
b \sqrt{a} →

√
a

\pi → π \int_{0}^{\infty} →
∫∞
0

x^{a/b} → xa/b

- Vinkki: vertaa allaolevaan esimerkkiin
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Dokumentin muokkaaminen

2. Lisää differentiaaliyhtälöt (3) ja (4) dokumenttiin.

d

dt
x(t) = ax(t)− bx(t)y(t) (3)

d

dt
y(t) = −py(t) + qx(t)y(t) (4)

- Vinkki: käytä \begin{align} ympäristöä ja & merkkiä tasataksesi

yhtälöt siististi. Vertaa allaolevaan esimerkkiin
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Dokumentin muokkaaminen

3. Tutki, mitä Matlabin komento magic tekee. Lisää dokumenttiin matriisi

magic(3). Anna matriisille nimi komennolla \label{nimi} ja viittaa

siihen myöhemmin komennolla \eqref{nimi}

- Vinkki: matriisin
[
1 0
0 1

]
lisääminen ja siihen viittaaminen.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Tehtävä B: Dokumentin muokkaaminen

4. Piirrä Matlabilla funktion cos(2x) kuvaaja välillä x ∈ [−π, π]. Käytä

piirtämiseen funktioita figure, plot ja axis. Lisää kuvaan myös xlabel,

ylabel. Tallenna kuva .png tiedostoksi ja laita se samaan kansioon

dokumentin kanssa vasemmassa yläkulmassa olevasta Upload

painikkeesta (ks. dia 31). Lisää kuva dokumenttiin.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

- Vinkki: kuvan lisääminen dokumenttiin

vTäytä tuottamaasi dokumenttiin myös A-tehtävän ja kotitehtävän

vastaukset ja palauta näin tuottamasi pdf dokumentti tämän viikon

palautuksena.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

Kotitehtävä: osakeanalyysi

• MyCoursesissa on kahden osakkeen päivittäiset hintatiedot

(xls-tiedostot) tietyltä ajanjaksolta:

- New Yorkin pörssissä noteerattu IBM, ja

- NASDAQ-pörssissä noteerattu Microsoft.

• Tällaisia ajan suhteen arvoja saavia muuttujia kutsutaan yleisesti

aikasarjoiksi.

• Tehtävänäsi on tarkastella Matlabilla silmämääräisesti miten paljon

IBM:n ja Microsoftin osakekursseilla on keskinäistä riippuvuutta, ja

miten paljon ne vaihtelevat Dow Jones Industrial Average -indeksin

(DJIA) tahdissa (käytä tarkastelussasi pörssin sulkemishetken arvoja,

eli close -sarakkeesta löytyviä arvoja).

• DJIA-arvot löytyvät myös MyCourses-sivulta.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

• Vinkki: Tarvittaessa Excelissä desimaalierottimen (piste tai pilkku) voi

vaihtaa kohdasta File -> Options -> Advanced

• Vinkki: Datan siirtämiseen .xls tiedostosta Matlabiin voit käyttää

komentoa xlsread.

1. Piirrä samaan kuvaikkunaan mutta eri kuviin (subplot, plot) kolme eri

aikasarjaa: IBM:n ja Microsoftin osakekurssi sekä DJIA-indeksin arvo

ajanjaksolla 2.1.2013 - 9.8.2013. Käännä tarvittaessa aikasarjat oikein

päin flipud -komennolla. Vaaka-akseleilla tulee olla pörssipäivät (siten

että 2.1.2013 on pörssipäivä nro 1). Osakkeiden kohdalla pystyakseleilla

tulee olla dollarimääräinen hinta (arvo pörssin sulkemishetkellä),

indeksin kohdalla voit miettiä itse mitä siihen kirjoitat.

vLiitä kuva vastauksiisi.

- Kommentoi kurssien samankaltaisuuksia ja eroja.
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Harjoitus 1: Johdatus matemaattiseen mallintamiseen (Matlab)

2. Piirrä samaan kuvaikkunaan mutta eri kuviin kolme hajontakuviota

(subplot, scatter): IBM:n hinta Microsoftin hintaa vasten, ja erikseen

IBM:n hinta DJIA-indeksiä vasten ja Microsoftin hinta DJIA-indeksiä

vasten. Nimeä akselit sopivasti.

Vahvista silmämääräisiä havaintojasi laskemalla Pearsonin

korrelaatiokertoimet (corr) eri aikasarjojen välillä. Laita kunkin

hajontakuvion otsikoksi tämän korrelaatiokertoimen arvo.

vLiitä kuva vastauksiisi.

- Kommentoi miten paljon osakkeiden hinnat korreloivat keskenään ja

miten paljon indeksin kanssa.
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